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mREERRE A HNERR, WESE File> New>Model, %58 BAERIMIBIERTS, LM T AR 728 Bl 2 5
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{E Project THEHEFF Notes BER P LRI H I AR R, WEFEATF. SR, NSRS, X6 BT
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an 3
T H KAR, Settings T HEAT H4r EEAMER. & BRI B b B BERE R i TRATERN S HRA S 5.

Rt LREA AR, ERAS LB EX B0 6 LR ARG & X .
Sertings T ARSI T 8 Mr%U, 8O MUk LR, 25 X8R

O  Near Field Cylinder Scan (35434

O S-Matrix (S %)

O  Transiemts (EESVD)

O  Response Predictor (WM T

O  Fourier Transform ({§ 3£ 4 )

O  Near to Far Field (iiiH3ixis)

O  Near to Far Cuts G330t 5 41)

O  Near to Far Conical Cuts (337337 3% [ #E 4 ifi )

ki Gy

7 Project YIRS 3 5 K AE FIE T . i BUEFE T THEX, piili Analyse ¥§ R 05 YU Project 205 3L —8IF B 74 R .
R FGESE T RMEETH PR E ORI E SR, WUt e 45 RAT O I0. CSFR S R A 2 W TR i 00,
REEErLE.

T H #

Frequency 500 Mz

@ g Transient

" @ @ cetch smafeedbest o

THEX

THEFIM T IFETLEMNSH, 3 H%%RHE CST MICROSTRIPES #1542 B RAAH H R, R IEERE R E X
PTHERK, B FikEa) CST MICROSTRIPES i, M SAHEHE EHF Open last used Workspace TR W] .

T H

o] LL{# ] File %88 24 17 Project T A L1 New 58 Open Fbs, HHIH BB TERK S . M TERX PERED
TiH, EPXAMMEFAGREGR, EFNAEERPIER Close Project IIT] .
MEEEN R B A H P, 4 Project YL HiE S %I H I ki ks 4B, 753 H N P IER Add Models/Files,
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S pidy Project THF i) Add Model Pbx. {EBE 53 B O b8 SAT SCH-ESMBIIRH .

RN Y S ] DURI R HE RS P MBS . TR, XA SR EX R MG H PR . AR A
RN SERLRERE b AR - ;
CARBEEET AL . WP S AME Build FRIRM SAT XfF, RS THEAMLAEL: 4 TLM XfF.
CORAE T TS0 Bro B UL BERL:  DUR BT XM SEAS L. CST MICROSTRIPES B il S 9™ g 4 #1
LAk 66 THE .

2t

TR H P AR AT, AUy MR L T 3T AU iky Edit Model, XM %8RS 0E Build 441 JF .

FIH Build, vJULGIEE G ABIRMJLOT i S, e XOTEB Mg R . e BB RS, R Build 5 885 G
A A B4 BT s i ke X

W R IELE Build PUL—PBi 4 TR TR, BriosiRE &4 & 3R —4 CST MICROSTRIPES i H 4.

giR

CST MICROSTRIPES ¥ 2&ikHTE Build " ESHULIOBIRL 28, JF dooe 5 BERAMELL45 . CST MICROSTRIPES (1)
Projects LT ST A AR, Xueg RS0 PR AR 2/ F.

b BB R A W RO, BT E 1 45 B HISANTE projedr 0 i o 0 48 2546 Build 13 it T 88, (B2 7F Projects
YEPREGEREH, WK a0 L0 View>Refresh, 8% St FS UUEH . & RENH I FIL#:

O %k
O =
O &
O szit

FREE ] AR O SRR A R, ARG LR ] LA IRV X R UIE R W O P Bn. SRS R E
XAEKA DA M, W, EXEEAEEA 2] A BRI . AR R W R,

5 K A 0 350 il 5 R R R A S H B R . BT Transformed field (45 R . X6 REE TiLHEEH
i EHYIEE . IR Ui R B . B R AN R R T Serrings TP B
fitm, 35 H () Sertings AT E SGESHVIE, W25 A 2 Bl 5 V) ik P45 R .

WMRMBEAEEHD, RTLUES S 20, (IABEMOAWNL T, SRR GEWME, SHPAE Projec
>Settings>Transients " 5€ AT B (E S50, KA QT 68, BiiRdh(s S Fioms. e, HHTEES
s Wb di AR, (mpulse Response) FSE(S S FIIWIRE Transient) .

BRREANGR, NELE Projects YL RAPRNITRIT] . fn SHI0LE BOE A A, o BRI Senings T H 0L
R T EE, SRS B2 RO R R R B) RN SRR BT A O ST, R P A S A
MNAEBRERDIER Analyse All, MBPBEGHL AR B EABRRBTEHEOM, BEXREDER
Tools>Options>Queue multiple job 1€+ S HIPERER FIRAL . BRI w] LLORUE BT A B8R AN BA B, 72 B ) 21
— ARG A TE PO SO, 35 H S8 A I Sertings R . IR EHET EAA T RAEH H REHE
B, ZRROOR. T SLR R, %0 RO N R B0 E P e B,

A%

Quewe TE5 H B I F o B8 T a0 0 T % 19313 . BT, Tools>Options>Queue Multiple Jobs &
REGEDTH. MRCLH MEHEHSL, BBRME - AMMEEN, KMRBADHE MESHEN NafEE2E. X
CRUER AR 28 CE R — W ] REAT — DM RHE S, JWEAE S H v bl G 0 351
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' patch smafeed.td.cnv
" patch smafeed.td.io
Y patch smafeed. td.io.sm
* patch smafeed. tim
* patch smafeed best
# W@ patch smafeed best cp

Files ¥LP 5 T TAELC P #9%5 H fEEAL 51, CARR BRI S /930 75 File YL AT LUTIT 240 H, HRE
Al A RERGE — A H GEPETH) o R RS A8 i 0 H s b 0 5 B S 0 SCft, a7 BRGS0 H .
WiE &, CST MICROSTRIPES T H AT #GE R T H By 3cfk, A nT LT fE.

Files VLEAFIH T HiAT SEAURYH ST, W BA L BB RIS, (E Files WE, Wit EH %% H L AdR
bR, (RS AR R R SR AT AT — R PR AE . PR AN E RN TRFHENI CTHEX., 5H.
BRRH ) .

= [ workspace (1 Project)
= 9 Patch SMA
= @ patch smafeed
" patch smafeed.log
patch smafeed, sat
| patch smafeed. td
|5 patch smafeed. td.cnv
" patch smafeed. td.io
' patch smafeed. td.io.sm
+ patch smafeed. im
+ patch smafeed best
+ patch smafeed best

@i, TIM X EdeZ 58D (93 1 AL S View. Analysis Fil Properties. i%4F View ¥4T T E ib2 J5
B, Analysis LET —NFREN, FIHTHAREH FZCHAG L TR, 3T TLM X, Analysis T30
SVH—Ti - 3D TLM Simulator. 1fij Properties ¥§ i na®s. f08 . Kb, CAFR GRS A WSS B . Sl g
15— IR REGAT, R O 2T TS A .

R R E 0 I, WSSO IR RS Update 4. &Y Update v %, 4 HATHIN A TE
FLAKTH L. 5 Projects WET B —F, SRTEXEBTLUBMBIREATH b . b R REA TR H H 4
di bR, M NN Add Files 5547 ¥ LRI Add Files Blbx, 705G H 098 O bk P 6 58|
TR H PR SAT . il 8 A0 0 th o] LA IR T0 E P BlER . 5 A0 B A R AN B R FE A IO R
FEAMBR M SRR .

W A

/B PR S 0 S RO B R . SO R AT B 30K R 8 7 SUAE 6 S AR K7 . IR IEHR 4 T 24 i
(i RHIFTH A . i

[Sep 01 - 2008, 0Z17:24 PM] > (using guessed boresight and polarization) L‘L‘
[Sep 01 - 2008, 0217:24 PM] > Calculating focus...

[Sep 01 - 2008, 0Z17:24 PM] > Calculating near field on cyfinder...
[Sep 01 - 2008, 02:17:25 PM] > Near to Far Field >

[Sep 01 - 2008, 02:17:25 PM] > Done

"L 7I 7,.,,7“ p— Y [A]
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Build Y3 CST MICROSTRIPES #4241 T — A8 T =4t B T HL 3 A T HCSF R Y b 51 0 sk A e e
W, ACIS. BRI S ILE CAD. CAE R 5 LT8R . 7€ Build vHF)H 3L L fof st B R i T HBE AT LL [ el
WAL S A KR, R HE . M. SRR R B Rt e s . IS R £ A Ik DA 0 2

Py s %

ik —EAY, 7R E VL b eT LME R SRR History #5301, History RESSLLA] M 7 (83 A ) Fndee 48 BERY (4 4
s, ESURMM BN T2, SO FRENEIR. ik Variables 14 E(+/-, BT SR o B H Y
BRERA. 75 Variables 3y G o] ELIT T4 i3 5 HEE AT V5 I s i 22 ik

£ Geometry Vil T3 TR HIFA A5 . BURLEY &4 W84 AT LASF LB LG (B35 7Y, B OB . mT LUE S 75
Geometry TS % EA RS, TEM RN P ARG IEMETUR O R BRMER — M. MBI, RE
7€ History B P RETT A KRS, $RF GG MAX MM, REAdEETEN. TEMESMXEHE DA MEA 2R %
o, LU ERREFT, W: 2%a+8. TEXERIESHE 19 0K “EN” BIHAR. BRRENE RS
SR T HARHIRYE, B AE T S B b I A0 42 7 A0 o 2 00 2 R e PR s, I 50 5 B AR [T LA X 40 i b i 2
R EIVEME. MBS E XM, AR bR 2 .

Build Toi& Sor el . R R TSR RMWIE CAD PSR WREEMABRMHE, Ban
O HARKR S 58 “history unavailable” .

BRI T B A

#M%mmwéé

HEREMBCLITITIMH, SF - HE S ST S8R DME R ML A ) s skam 4, (BT
EHIGEMBGH P ETRRE. I HURSRAS.

o

H ACIS THFWEEDaMEh . EFT I SCfFR, URSR IR B S aTE R g sicfk. ¥k A F] CST MICROSTRIPES
HER, B28FE%.
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wr =

BHRRGE R ACIS SCA (SAT) . Fidi ik ACIS ¥Rt 286 ACIS JLT 8 — & A7 8] SAT b, ixee
R AL H AT RE S LM RS E X, M E . B, 0 ERRER L & 0F. BURH] CST MICROSTRIPES
THEGRO AR, . 6 E SRR RIS ACIS THAEM, (FR L BERY R o] BLEE MR oK
B AR ACIS T RN . Save Body... AT LK BRI SEASAF(RAE A —A SAT 0. X SR G AT EATE ILE
BiRh S AR TSR, I S e CPR . AER TR S 5E ) AR B0 Ar.

Build WA A IGES. STEP. STL. DXF. GEOM. NASTRAN Ll PDML X, WEFEMRF &R
AWATLLF A, IGES. STEP. STL. DXF JEili /i) CAD KX, ZRAN CST MICROSTRIPES o LLJT] GEOM #%
. NASTRAN 4] LA H e X 45 H9 2t « Flomerics FLOTHERM #1 FLOEMC (1) 2007 & o] BA{E H] PDML #50.
XL AT E 4 EMC 14 30

IGES 8URHUE A RN RGEM G AR, RAZHE. 0%, XA T MRREMLCE, . UEERD, AURE
if LA B i «

V)R A A2 e ke PR A S 20 DL 3 85 R D)) i B R A R, A e ) (R

FOE AP WRATHIF (B BRES AN BILE B 2B SR, WGP EERS K. B Build X
SEAE ROk, AN I AL R g — OB R 5 o o3 Y P Ak A T LA AL R e T E TR B L

A e i 1 KA o R SCBA AT BB AR o IXREIIE, ENI7E Build R ETEAER . (Kt G\ o R08 i 7 i
A L I B K G A il

bH T R ARG B 1 A 22 (T AT e, PRIRGX B AME S S AR BEUR RGP il FFF, EA RS TER
B B2, XNETOEEDERTR. R, RAITE DR S WUIERRD, @wARZFY§ D,

AT DUH SRR LU (R 28 St (BRATA MR L AR, FOh TR EEN THESREB. B, BMImekaTLl
1R HOF A S T

B4 AR BL A LABROT 04 9 s I B RY o, i B AT T ABAL SR R GRS RO - R SR,
IERER AR SE T, R0 ol LU SEREAT i i 2«

IGES G ANBREAIFRRLEE . ik, € IGES T, SRR SRR GEE. d& M km&m Kem. w%E
AR EEATHRC B, 254 T T %A EREESE, dHHREM SRR ER. KRR, RY
FREA P46 G H B R S

CAD $R{FIH W 224 52 KA, 830 h 2R 5 i 10T S sUE A IGES 3 . F N\ Build 19208 s R MBS 0 (5
B, WRER. Jig¥kimn) . WAL B RERARE . DORIXH AMERT Clak bRl &, i HL i 3T Lt flE R B B R AT
Bt BECEEASERT XFREAMTE 2.

Tmmngorves: Ofomfie 020 @30
STL import — —— e T e

Hle Typs | = By 1 Text

¥ MASK curves 3T LABS (-5 Nl Bl . ik Face healing W LIS 318 — /4G ANiuill, M@ {RBd
T AR A BB R — AR . UG S AREEE A s thnd, MRS mESEE PR EZ G EEY.
BEA KT KAGE Trimming curves. —~ 1GES LM # 4L & 3D 1 2D 3R M1 2 M4k UL fg & o0 R X R i
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brid, EAEIAMERINCR From file, BRI RAT @R, MLl KGR 2-D 5 3-D VIR, wREANDE
SeA R MMENTEAR Ak, H IGES S PR G SRt ie X, WA BAFIEFE 3-D VIR, RA 2-D Mg B4
MR, (EATESE LM SRRk 2 T 9 5%

9&9@

RS LL IGES. STEP % STL R Sili

#2 (4)

EAE R RS E S ANE, DRI ACIS B, IGES X 5\ i) i Bl 42 6 4 B il FUaf 5 — A i 195
WAL SR T AR AR SRR, B AR R T R A4 AN TTH TLIE (S B A SRR

T ACIS BRI 2% 1E-6 TR BT LA, AT 1E-6 i, AT S, XA 2 2 R4 biid S
A A UL R 2 ] e K SRR . TR AAEER AR RGO AR B AR, W AT I
Bl REmE LR R, SORTEAT AE R LLGE I 2 E BK

HF - RASEANMNLERR, BTMERER SRR N A MR AR & MR L. H, mRERET
FEAfTEANE, AELHSnmmY, BasLiesml@iie R, BRI AR E, (R~ RH
Mg, A REL RN, UK BT T 2 S B Al b Ay pe T bR

af L b A B o S S IR, R A R M A S b . B RO HEGIE T MahiE L, 1
ST VW UL B SRS B HL. 1B S ThRER S LU R =B B

O b 2 ol 5 b e b e X
O EHRAIE R fE B R — A 1k
O SEEH LR

Auto SUEREPSE TR VA PR L= 22T M. BFoVie— B, Clde Ern LNz, mi
ENPT Awo. AT RANKL N Eeifi A2 &5 A P A 2. TWEWE, E85 - NE, BoaEmlEnEsax,
R P el AR SLEEAT 45 0. BRILASh, ATUKPER —BrBis A A, B, o] LU BRI A a4

X 1] Awto J5 BRI BN 20 22 REFCIR KA S8/ 2230 0 9 VE-5. 45 R 23 MIR A 22 2258 0 I 3 I K2 2 B/ AE IGES
K RPN R LLER S A, MRMELR DA EE, BREEU DR A ETIBE, &
ZH&. -

Display 10T AR K447 ol ELAG 4k it K. Spline faces YUHH P04 cb 8 A3 i 46 b e T CR T 27wt oK. R
RO A AR, IEEE b QOF . PUEEG, BROR i akER i f R bE LR RIEN, WEMNAE. X
SR THATREE AL MRS S, TRUMMItAZE, mREER RS B usE
GUUERT — P HEma e mE, Eia il 4/ Query THREWIAMAEUR T IFERAINT. Edge gaps &%
e T L E AT S EE N L. Vertex gaps 1] 5 7R T 86 AL By 10 88 3 i 76 R T 1) 2 2596 T A ()

B

fiidi Check, &M MK T ERBRELRMN “acischk” M. BFKATIT - MC P ARUBERZN L. mRXMH
RN, BARWIEAEY, ATHEGE. WREW LN IGES FAN, BAKERFERHEKR, BAKHIL “Eror:
duplicate vertex at x, y, 2" 3X —HE B B W RS HMBLXA R, B4 00 BT A 1 00 A R0 AN Rt AE S Sk B,
B iz o] LLEEAT 9k 8 0

EAE O PEAE T IS UL BRI AT . Clean RIRMMBRBERY @ XM AT R BIL. B, %
CAD $F BR e QIR & BUH i 6 A IS L . SRR T ACIS JKBL, S ERMER AR A0, kT LA
XA UpRER LN

i B B AR T R, AR AW P E Separate lumps ShfEE TS 8 G BIR KR ARSEMG . th 2
A LR AT LA “acis.chk” OIS RO R k. B RA P REAN M. BREUERENEE
Wil B B PR F AR R £ o) B, RS2 AR ROR .

SRR W AR 5 KW, AT LEA] Convert to spline JX A~V 3T & SR . W — DA E T WL,
FLZ Sl LAY, 8 1 50 380 2 T 5 BOR UG (R E 28 230 BBl X e T 4k i oK, 5 1F 6 PR e

o S0 i A (B RS RO, S A A T 2 b AT (o) R S, ATk L BRI R S AR 1
). 8T ABRZNEREDENEIERIEY, DR - MEBRaTRAYE. R - RRTTITA R IE
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RS T, & — DR RBUR 00, AW 2R B 2 HER . JXaT LT Reverse body Mhfie RAE 3.
A a] R A PN OL: JGES SOl KR Em — ARG5S, 18 52 J5 LRk £ - B ANk
k. R Add face WG — T INEN A L. WiT, VFBL EHEEGERSER— 9. e K -
F B2 N I, il BT T Y L AT 5 S e AT AT B R DA TRIA T L ) B i A0 P A T A LT &, PR )
AL R AT T SR T oI LA Remove face SeAIX A IS BR , 15 45 A 1] £ 9 G — A A4 1 F 3 A s m 319 i .

f&#h 6 L1 op IS AN IhE L Make Faceted, “€JAR/NA V- @) A0k 5468 5230 - 0 80 o5 /00 1] 5 BT M
A 2 0] EARBX A Dh RE G 5E WA/ = Mt . SR IR W R RORAR K, (B AT BLR] Clean #/> H SR

Hirhs 1 L

Undo F1 Redo P KAF BB [ i8R ] J5 6 4, (EZ AL F AN —DRE. HLERREEREN, BnR - PREER
FZ ARRARE, R EETIERA, BaZiRuORRERR ER.

tH T AR B, BRSSO th R AT R P AR ER R BRI G R, R MR Ak, BURR
LB R Y A A B MR RO . ER 2 WIRRE . T 7E Undo Btk R EERL,

it

EF DA ER T Rk R ILARR, SR T . WL 4G Number of copies YE Jy— 1 K F 1 9%, aTLL
HATEEEH]. WS BRI R0 R, FECR PRI LLYE In place, Translate 7 Rotate *H it T2 % .

W iEH Translate 3, Rorate. 2 FA @A LA T g — @ AT &4k, @lln, WA EART Ve, B
/A (10, 0, 00, MAE ATEIAZHNTEREDEEE (10, 0, 0 , TS AWAHSTFREGEDEFE (20, 0,
0 .

WARH PR RS B S R (AR RAHERIE)  WALER Unite all copies with
original JEIR, PRI B DILIPOE. XTI TR, ReAREbd. HERSRs
PE 2 A5 b R PE G 47 (E BRAER) ACIS W iAh . 9 STBIBERY s MRERY 410 =, Rt 2B G . 8
HAETF MM R S R IR SE B R B BT L sic e (B R G X B AL AT R R ) S 5 LR . SRR R A
AR R, REFRETHB M. Extract Copy Fl TR AR BEAR &, £4H5 PORGFLE.

Iz

IEFERA RSN GG R i Ib 0 B R, KPR BRI A . IR R ek <Corr>12, ATLLE AT
FAGEFE, TSR W C2EFROWIE. i Delete 7T LABMBRFTEWK. RATAME (RLEFRLEHTHH
A s BB . 6 5T B AR 2 A s .

B3
HEFEIA B S e PIESE A LR, T DU A AT TR . SEEA e 1% — 5 Ee B AT R

Y i

AT H AR (A i {6 BBl S0RE . Wk Tl BRal a0 i AR T LU M AR A . 24 F— B kg,
TR EMEAH. PRURTE. BURTLL. W THbsm, 28/ %bhlmprEedas (nfisbbit TR&
2003, WEREHRUM AR DAEMELLAGEE. M FHA0E 2ExREMEHERIERK. § 19
se it 2 R, nTRAVHSE - A BRI B s R . %EE B AR B ATE N LA RS, R, R
IEFE A, HHARMEER RN I CGEMBIERK) MERR, WARDLYE EX AR

T &/ B @

b e 3 SR v LN A EAR TP L iR ST NI A Y S UL //RE SUZTN REEA A & 3 ehd [a)ioh. 3 (/LN oEA o =gl
BUE New name SCAHES, U502 HILALE color WiTEHE . L i ci color RiTEHE, W LAKEER (0 2k — Fb 5L A (0
SESC—FRLP B X, sidh Apply SERAIEEIEMARNTES. EFsEETlNEafAaG, BREATES
R B SGE P N B G R A rh e, AR BRI, FETENEDELHRLAME -, FsHEwiE
4.



